California Energy Commission
E-Filing Document System (eCRMS)

Document E-Filing Process
Step-By-Step Guide
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1.0 IMPORTANT Information

The Energy Commission system does not delete or remove comments or documents once
they have been accepted (docketed) by the system. Check your document carefully before
submitting your document to the system.

1.1 CONTACT Information

Dockets is available during business hours 8am-5pm, Monday — Friday, closed most
Federal and State Holidays. docket@energy.ca.gov

2.0 Accessing the System
Go to the California Energy Commission homepage at https://energy.ca.gov
1. Click on the PROCEEDINGS arrow for the drop-down menu.

(?Glov Share: f L4 il‘l E About Careers Contact Events MNewsroom Resources @Settings

@ E ﬁ EIR YR E‘C?M MISSION Enter keywords, e.g. Tracking Progress Q

HOME PROCEEDINGS ~ RULES AND REGULATIONS v PROGRAMS AND TOPICS FUNDING v ViewAll =

Proceedings

Active Proceedings 00% clean energy future

Business Meetings oy
Dockets -
B . - e

E-Filing and E-Commenti

Opportunities for Public Pagticipation

Siting Cases

2. Click on “E-Filing and E-Commenting” which will take you to the E-Filing and E-
Commenting webpage. Click on “E-File Document for a Proceeding” in the POPULAR
LINKS box.
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3.0 Account Creation and Profile Maintenance

The e-Filing system is for use by all proceedings (Dockets) by power plant license Applicants,
recognized Intervenors, submitters, and Energy Commission staff to file documents in a
proceeding.

1.

The system will take you to the Log In screen shown below.

Research | Transportation

=
CALIFORNIA
@ ENERGY COMMISSION
GOV

Home | About Us | Analysis & Stats | Efficiency | Funding | Power Plants  Renewables
» Please login

Log In
Email |

Password

Sign In  Forgol your password®

Don't have an account?

Register as a New User

You will be required to Log In with an account to proceed.

The e-filing system is a quick and easy way for the recognized parties to file necessary
documentation for proceedings. The e-filing system requires document submitters to
register before submitting documents. The system allows submitters to submit documents,
submit confidential documents, view submission history, update the submitter profile, and
recover forgotten passwords. The first time you log in, you will need to Register as a New
User.

You are required to complete a simple, one-time registration to create your e-filing account.
Mandatory fields include name, email address, and password. You are asked to provide a
security question and answer in case you forget your password.

If you are filing on behalf of a client, you need to include your organization’s contact
information, as well as your client’s information. This will simplify searches for multiple
clients. You can add an unlimited number of clients into the system.

You will also be required to verify a CAPTCHA to ensure the profile is being created by a
person and not by automated scripts. You will need to check the box next to “I’'m not a
Robot”. A screen may pop up asking you to verify specific pictures. Upon approval, you will
get a green checkmark in the box.

After you agreed to the Terms of the Use and click the Agree & Create Account button,
the system will register you and send an automated email informing you that you are able
to log into the e-filing application and submit documents.
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Stats Efficiency | Funding | Power Plants | Renewables | Research | Transportation

Register

noted by an asterisk (*) are required

r | { | ation Ir ma
Full Name * Organization* @ M
John Q. Public self
Email Address * Business Address

Johnqpublic@email com

Password* @ Password F Address 2

Security Question * ¥ " Business Phone Number Business Fax Number

e Name and PIN

Security Answer *

Queue 1234

Phone Number *

916-123-1234

@ -
not a robot .

Terms of Use: By submitting the

understand that | am

lems that may

Agree & Create Account

3. Next you will be redirected back to the Log In page where you will see a message
confirming your account. Please note the messages in green text, they show the status of
your previous action.

Home | About Us Stats | Efficiency | Funding | Power Plants | Renewables  Research

* Plaase log in

Log In

Password

Don't have an account?

Register as a New User

4. You will also receive an email confirming the setup of your account.

our account was successft

H efiling@energy.ca.gov (efiling@energy.ca.gov) Add to contacts 1256 PM

Dear John Q. Public,
Your California Energy Commission e-filing account has been created successfully. Please login to the California Energy Commission e-filing website to submit an e-filing.

Thank you
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3.1 Lost Password

If you forget your password, you can reset it by clicking on Forgot your password on the Log In
screen.

Forgot Password
Email john.q.public@email.com
Security Question  Middle Name and PIN

Answer queue1234

/

Submit

1. Next, the system will prompt you to enter your registered email address.

2. The system will ask for the answer to the security question you set up when creating your
account. Click Submit.

3. Next, you will see a pop-up (shown below) letting you know that a new password has been
emailed to you with further instructions.

5. If you do not have access to your email address, you will need to create a new account. If
the email address is forgotten, the user will need to contact the Docket Unit Staff to
obtain this information. docket@energy.ca.gov.

3.2 E-Filing a Document(s)

The process of e-filing evolves three steps:

1. Selecting the proceeding (Docket Number) and your role in the proceeding.
2. Uploading one or more files and adding descriptive information (metadata) for each file; and
3. Reviewing the document(s) and accepting the terms and conditions for submission.

After you Log In, you will be able to select a proceeding and set your role.

When you Log In, you will come to the custom welcome screen, also known as the Dashboard.
From the Quick Actions dropdown menu, you will select Submit e-filing.

ENERGY COMMISSION

Dashboard Profile Chients Filings

Welcome John Q. Public

Your Recent (,"-”\‘WQ .[\C:.\“'.!'.‘j. Submit Confidential e-filing &

Help

Showing the latest 25 results Add Client

TN# + Date Docket# Project Title Document Title Visibility Status
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1.

The first step is to Select a Proceeding & Submitter. To select a proceeding (docket

number), enter a few consecutive characters in the proceeding name and click on the
magnifying glass search icon. Alternatively, click on the View All Projects link to select

from a list or enter the Docket Number in the proceeding name.

Submit an e-filing

@ select Proceeding & Submitter

Step 1: Select a Proceeding & Add Submitter Info

]

Fields denoted by an asterisk (") are required

Select a Proceeding

Submitter Info John Q. Public
Self

Your Role in this Proceeding * j

i. From the list of return results, select your proceeding using the Select button.

Select a Proceeding

[~ Show expired, on hold, and suspended projects

4 Docket#  Project Title Status

00-AFC-14C El Segundo Power Redevelopment Project Under
Compliance Construction

01-EP-14 CalPeak San Diego 49 5MW Peaking Power Operational

Plant, San Diego, CA

01-EP-14C Calpeak Border Emergency Process - Operational
Compliance

14-AFC-01 eFiling Test Power Plant In Review

Capacity

(Mw)

630.000

50.000

50.000

5000.000

County
Los Select
Angeles
San Diego Select

San Diego Select

Sacrament Select

ii. Use the drop-down menu to select Your Role in this Proceeding:

Submit an e-filing

o Select Proceeding & Submitter
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iii. If you choose a Representative or Consultant Role, you will also need to Select Client.

Submit an e-filing

Step 1: Select a Proceeding & Add Submitter Info

Fields denoled by an asterisk (*) are required.

Select a Proceeding *  eFiling Test Power Plant Q o View All Projects

Submitter Info T Winter Esq
Winter and Associates
100 16th Ste, Suite 20
Sacramento, CA 95833

Your Role in this Proceeding*  Applicant Representative =l

e * | abe] 1 @ | orview Al cClients
ABC Powerplant, Sunny Solar, LLC
123 Sunny Drive . . .
Sacramento, CA 95833 #¥and Retum to Previous Page

iv. First, you will need to add your client’'s name in the Client’s tab on the dashboard.

2. You will proceed to the second step by clicking the Continue to Upload Files button. The
second step is to Upload Files. You may upload as many file(s) as you need up to 30MB
per file.

CALIFORNIA
ENERGY COMMI

Dashboard

Profile

Clients Filings Help

Submit an e-filing

Step 1: Select a Proceeding & Add Submitter Info

Submit an e-filing

n Select Proceeding & Submitter 35
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SUDMIt an e-ming

o Select Proceeding & Submitter o Upload Files

Step 2: Upload Your Documents

Instructions:

Select Files: Select the files you wish 10 upload by clicking the 'Seiect File(s) to Upload button. Multipie files can be selected by clicking the button again o, in certain
browsers, selecting muliple files. File drag and drop is aiso available in certain browsers. Note that file requirements apply.

Upload Files: Once your files have been selected, they will appear in the 'Files Awaiting Upload” section. Click on the ‘Upload' button to transfer the files. Note that in
some cases, files may be automalically convered to Portable Document Format (PDF) once they are received

For Mac users with IWork software, you can create a PDF il for upioad by (1) Selecting Print from the File menu; (2) clicking on Save as PDF... from the PDF drop
down menu; and (3) Clicking Save fo save the PDF file o your computer

3. Provide Details: After your files have been upioaded, they will appear in the ‘Uploaded Files' section. Edit the file details before continuing.

Note: Multiple documents uploaded within the same transaction will be given the same transaction number. If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements
or your document(s) will be rejected.

Documents uploaded afler 5:00pm PST/POT will be docketed on the next business day. Note that in some cases, filing deadlines may be sel earfier than 5.00pm PST/PDT.

1@ File Requi

Drop files here

Select File

Details Required [}

You will need to edit details of the upioaded files before continuing.

NOTE: Password protected documents and zip files are not accepted and will be
rejected.

Step 2: Upload Your Documents

Instructions:

1. Select Files: Select the fles you wish lo upload by cicking the 'Select File(s) 1o Upload bution. Muliple flles can be sedected by clicking the button again or, in certain

browsers, selecting multiple fies. File drag and drop is also available in certain browsers. Note thal file requirements apply

Upload Files: Once your files have been selecled, they will appaar in the 'Files Awaiting Upload section. Click on the 'Upload” button to iranstes the files. Note thal in

some cases, files may be automatically converted to Poriable Document Format (PDF) once they are received

on Save as PDF... from the PDF drop

g Print from the File menu, |

For Mag usi ih Work s
down meny; and (3) Clicking Save fo save Ih

U cal

3. Provide Details: After your fles have been uploaded. they will appear in the "Uploaded Files' section. Edit the fle details before confinuing

Note: Multiple documents uploaded within the same transaction will be given the same transaction number. If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements
or your document(s) will be rejected.

Documents uploaded after 5:00pm PST/PDT will be docketed on the next business day. Note thal in some cases, flling deadiines may be set earier than 5:00pm PST/POT
)
Select File  m—

You will need 1o upioad files before continuing ance! and Retum 10 Prey

3. Upload your documents by clicking on Select File(s) to Upload. You will browse out to your
local computer or device to select the document(s) you wish to upload. Alternatively, you
can drag and drop files into the Drop Files Here box.
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4. After you select your document, it will appear in the Files Awaiting Upload (shown below).
To complete the process of selecting your document for uploading you will click Upload
File(s).

Files Awaiting Upload

statisbio.xIsx - 8.56 kb (Pending) Remove

=P Upload File(s)

5. After you click the Upload File(s) button, the file will appear in the Uploaded Files
area as shown below:

i. If you have selected a wrong file or want to remove a file before providing details, then
you click on the Remove file button beside the file name and the file will be removed
from the Uploaded Files list.

Uploaded Files

You will need to edit details of the uploaded files before continuing Cancel and Return to Previous Page

ii. Additionally, you can always click Cancel and Return to Previous Page.

Uploaded Files

statisbio xIsx WEETREL TN (7 Edit details ® Remove file

You will need to edit details of the uploaded files before continuing

Cancel and Retiin to Previniie Pane
Cancel and Return to Previous | age

»

. After you upload your files, you will need to Edit Details of your file. The label Details
Required indicates that the file details need to be added to the uploaded document before
moving forward.

Uploaded Files
statisbio xlsx WEETEREN TN (7 Edit details ® Remove file
You will need to edit details of the uploaded files before continuing Cancel and Return to Previous Page
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7. After you select Edit Details the Update File Details screen will pop up. It is important to
fill out as much detail as possible about the document because these are the searchable
metadata fields.

Update File Details

Fields denoted by an asterisk (*) are required

statisbio. xisx
Filz Name

Title * Bio Statistics|
114 Character left out of 128

1024 Character left out of 1024

Subject{s) Biological Resources x
Clear Selact All
Document Type Document
Pages

Addressed To CEC/Docket Unit
113 Character left out of 128

Update File Details Cancel

*File Details are required (tips to populating below).

Title: Review the document to give a clear concise description. Focus on the content of the
document rather than the “to” and “from”, which will be captured in other fields. Avoid
abbreviations and acronyms since this is a searchable metadata field and use Title Caps.

Document Description: If further information is needed or helpful it should go in this field.
Additionally, if the document is being filed with multiple attachments it should be noted here.
(Example: Attachment A to Preliminary Staff Assessment).

Subject: If you know the subject(s) that apply to the filing you can add them from the
procreated drop-down list in this field. You can add as many subjects as needed.

Document Type: From the dropdown list, you can select from the following document types:
AutoCAD Drawing, Document, Google Earth Data, Map, Meeting Recording, Photograph or
Shapefile. If you are unsure what Document Type to select, then you can default to
“‘Document”.

Addressed To: This field should always be entered. If the document is not directed to any
individual person or company, then you should enter this field as “CEC/Docket Unit”.

Notes: This field is for the Submitter or Docket Staff to input any pertinent notes about the
filing.
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8. Once you have populated all the metadata fields, select Update File Details. You will need
to do this same process for every file you plan to submit.

Update File Details
Fields dencted by an asterisk (*) are required
Hama Hatisbio. xds)
Titie >
B =
e
Document Type Documen t bt
Addressed To CEC/Docket Unit
113 Character left out of 128
-

9. After you have entered the file details and the labels of all of the uploaded files read OK, you
move to the next page by clicking the Continue to Review and Submit button.

10. The third step is to Review & Submit your filing. Review your filing to ensure accuracy and
click on the I agree and Submit button. If your filing is not ready to submit, you still can use
the Edit Details, Remove File and Cancel and Return to the Previous Page Links.

Uploaded Files

mtf, Edit details & Remove file

Continue to Review & Submit ’ ancel and Return to Previous Page

Submit an e-filing

€ Select Proceeding & Submitter €) Upioad Files o Review & Submit
e Rea\ I

Energy Commission

. ‘ 1 Agree & Submit '
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11. Upon successful submission of the files, the system will provide an onscreen message.
Next, click Continue.

Weicome John Q. Public energy.ca.gov Logout

ENERGY COMMISSION

DASHBOARD PROFILE CLIENTS FILINGS HELP

#*¥our e-fling was submitted successfully. An e-mail has been sent fo you confirming your submissio

Welcome John Q. Public

Your Recent e-filing Activity

Showing the latest 25 results

+ Date Docket # Project Title Document Title Visibility Status

10/11/2013 14-AFC-01  eFiling Test Power Plant  Bio Statistics Public
K 1 page(s)

Pending

12. The system will also send a confirming email notification to your registered email
address.

13. When you click on the Continue button, you will be redirected to the Dashboard. In green

highlighting a message confirming your filing will be displayed. Your filing will also show up
in Your Recent Filing e-filing Activity list.

e-filing Submission Complete

our e-filing was submitted successfully, and will be reviewed by the California Energy Commission before it is published to the Docket. You will receive
n e-mail confirmation regarding this submission

Once the California Energy Commission reviews your e-filing, another e-mail will be sent to you notifying you about the publishing status of your e-filing

hank you

. all Continue

14.Once the Docket Unit staff approves the document, you will receive a confirming email with
a link to your docketed document.
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Dear John Q. Public,

The following 1 Document(s) that you submitted to the California Energy Commission (Docket Number 14-
AFC-01) were approved and published to the California Energy Commission website:

e Docket Number: 14-AFC-01
Project Title: eFiling Test Power Plant
TN Number: 229732
Title:
Description:
Filer: Patty Paul
Organization: California Energy Commission
Role: Commission Staff
Submission Date: 9/13/2019 11:27:06 AM
Docketed Date: 9/13/2019
Subject(s): Biological Resources
Submission Type: Document
Page(s):

Thank you.
09/13/2019 11:27:40.832

18. If the Docket Unit staff rejects the comment or document, you will be notified via email. The
email will provide the reason for the rejection.

Dear John Q. Public,

The following Document that you submitted to the California Energy Commission
(Docket Number 14-AFC-01) has been rejected:

Title: Bio Statistics
The reason for rejection is:

The document was not searchable. Please make the document searchable and refile.

Please contact the Dockets Unit if you have any questions.

4.0 Creating the PDF

To save your work as a PDF in Microsoft Word, Google Docs, Apple Pages, or other word
processors involves pretty much the same steps:

1. Open the document you want to save as a PDF.

Click on the File tab.

In Word, click Save As | PDF from the drop-down menu.
In Google Docs, click File | Download | PDF.

In Pages, it’s File | Export to | PDF.

In the file name box, .pdf will automatically appear at the end of your file name.

o 0 bk wbd
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You can save a document as a PDF by clicking File | Print. An option for Print Preview will appear.
e Under Printer, change it from your computer printer, such as Epson, Canon, or HP, to PDF.

e Click Print and it will save the file as a PDF on your computer.

4.1 Making a PDF Searchable
Using Adobe:
1. Open Adobe Acrobat/Adobe Acrobat Pro on your computer.
Click Open.
Find and select the document you want to make searchable, then click Open.
Head to Tools and select Recognize Text.

ANl S

Press PDF Output Style Searchable Image.
6. Select OK.
You can search the web/internet for other options.

4.2 Checking to make sure a PDF is Searchable
Making sure your PDF is searchable.

1. After opening the PDF, try searching for a word known to be in the document (preferably a
word that appears on several different pages) by clicking CTRL-F and entering the word in
the Find box. If text highlights, it is searchable.

2. Open the PDF in Adobe Acrobat, then select the "Edit" menu > "Select All". This will select all
of the text in the file. If nothing is selected, there is no text, and the file isn't searchable.
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